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1. Mik& on selain

Selain (browser) on ohjelma jolla luetaan verkkosivuja eli surffaillaan. Kuten muitakin tietokoneohjelmia,
myd0s selaimia on erilaisia. Eri selaimet sisaltavat kuitenkin padsaantoisesti samat toiminnot.

Erilaisia verkkoselaimia:

= Internet Explorer (IE)

Kéytetyin selain, tulee Windowsin mukana.
= Mozilla Firefox

Avoin lahdekoodi - ilmainen.
= Muita: Opera, Safari

Internet Explorer on selaimista selkeésti suosituin. Eri tutkimukset raportoivat hieman erilaisista tuloksis-
ta, mutta k&ytdnnossa Internet Exploreria kayttédéd n. 60% ja Firefoxia 35% surffaajista. Internet Explorerin
suosio on viime vuosina ollut laskussa tietoturva-aukkojen paljastuttua. Selaimen uudessa versiossa tieto-
turvaa on kuitenkin parannettu ja selain on onnistunut sailyttdmaan asemansa kéytetyimpané selaimena.

2. Selaimen perustoiminnot
Kaikki edelld kuvatut selaimet sisaltdvat samat perustoiminnot. N&ité ovat:

= halutun osoitteen syo6ttd osoitekenttédédn
= sivun paivitys

= sivun latauksen pysdyttdminen

= paluu edelliselle sivulle

= sivun vieritys pysty- ja vaakasuunnassa.

Perustoiminnot on selaimissa oletuksena sijoitettu ndytdn ylareunassa nakyvaén tyokaluriviin, josta niitd
on helppo kayttad toimintoa kuvaavien painikkeiden avulla.
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Kuva 3: Operan tydkalurivi

Siirtyminen sivulle, jonka osoite on tiedossa, tapahtuu kirjoittamalla osoite selaimen osoitekenttddn. Kun
osoite on Kirjoitettu, painetaan nappéaimistolta joko enterié tai selaimen Siirry (Go) -painiketta. Selaimen
oikeassa ylakulmassa oleva kuvake alkaa liikkua osoittaen sivun latautumista. Jos sivu l6ytyy, sivu auke-
aa, muuten naytélle ilmestyy virheilmoitus.

http://www.ltdk.helsinki.fi/tuke/opettajille/kurssipalaute/palautelomakkeet.htm

Edellinen linkki on virheellinen. Paasivu 16ytyy kokeilemalla, mik& osa osoitteesta on viallinen. Aloita
poistamalla palautelomakkeet.ntm ja paina selaimen Siirry-painiketta. Poista tarvittavia osoitteen osia,
kunnes 16ydat toimivan sivun. Mikali sivu ei edelleenkddn aukea, tarkista, ettd osoite on kirjoitettu var-
masti oikein kaikilta osin. Joissain osoitteissa alkuosa on muotoa https ja joistain osoitteista puuttuu ko-
konaan wwwe-alku.

3. Aloitussivun maarittely

Kun selain kdynnistetdén, aukeaa aloitussivu (Home page). Aloitussivulle p&éstddn myds painamalla se-
laimen tyOkalurivilla olevaa talopainiketta. Aloitussivu on vapaavalintainen sivu, jonka kukin kayttaja saa
itse asettaa haluamakseen. Aloitussivun voi halutessaan vaihtaa, sen ei suinkaan tarvitse aina pysyéa sama-
na. Verkossa on erityisesti aloitussivuiksi suunniteltuja portaaleja, jotka tarjoavat hyvin monipuolisia pal-
veluja séatiedotuksista keskustelupalstoihin. Sivut siséltdvét runsaasti hyodyllista tietoa, mutta ovat vas-
taavasti toisinaan kohtalaisen hitaita avautumaan. On kaytt4jan oma valinta, haluaako hén aloitta surffai-
lunsa portaalista vai joltakin hieman kevyemmalta sivulta.

Aloitussivu madaritellaan:
Firefox: Tyokalut (Tools) > Asetukset (Options) = Yleinen-vélilehti (Main-valilehti)
IE: Tyokalut (Tools) = Internet-asetukset (Internet Options) = Yleista-vélilehti (General-valilehti)

4.  Etsi-toiminto (Find)

Selaimet sisdltdvat ndpparan Etsi-toiminnon. Etsi-toiminnon avulla yhden verkkosivun siséltd etsitdén
jotakin tiettyd sanaa tai merkkijonoa. Etsi-toiminto aktivoituu kaikissa selaimissa néppainkomennolla
ctrl+F.
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5. Uusi selainikkuna ja valilehdet

Joskus verkossa surffaillessa tulee tarve Kkatsella useita sivuja samanaikaisesti. Sen sijaan, ettd avaisit
useita erillisid selainohjelmia, kannattaa kayttaa selaimen vélilehtia. Vélilehdet ovat uusia verkkosivuja,
jotka avautuvat saman selaimen sisalla.

Internet Explorerissa uusi valilehti avataan painamalla auki
olevan valilehden vieressd olevaa painiketta. Uusi vélilehti ¢~ Cmmimmomset r—]

saadaan my6s nappainyhdistelmall ctrl + T. % & Qe

Firefoxin nadppainkomennot:

ctrl+T: avaa uuden vélilehden

ctri+hiirella linkkia: linkki aukeaa valilehdelle

hiiren rullandppaimelld linkkia: linkki aukeaa vélilehdelle
ctri+tab: siirry vélilehtien vélill&

ctrl+W: sulkee valilehden

6. Kirjanmerkit ja suosikit

Kirjanmerkit ovat pikavalintoja joita painamalla pé&set suoraan haluamallesi sivulle kirjoittamatta osoitet-
ta osoitekenttddn. Kirjanmerkkeja kannattaa alkaa keraté alusta alkaen. Etenkin kirjanmerkkejé kannattaa
kayttdd silloin kun kayt toistuvasti samoilla sivuilla, tai jokin kdyttdmdsi sivu on vaikean linkkipolun
paéssa.

Kirjanmerkit ja suosikit tarkoittavat samaa asiaa. 1E:ssd termind kdytetdan suosikkeja (favorites), Firefo-
xissa taas termind on kirjanmerkit (bookmarks). Eri selaimissa kirjanmerkit on toteutettu hieman eri ta-
voin, kayttotarkoituksen séilyessa kuitenkin samankaltaisena. Yksinkertaisin tapa tehdd halutusta sivusta

kirjanmerkki, on vetdd sivun favicon (Favorites icon, osoitteen vasemmalla puolella oleva pieni kuvake)
suoraan selaimen linkkiriville.
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Toinen tapa lisété kirjanmerkki selaimeen on néppdinyhdistelmé ctrl+D.
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Kirjanmerkin ominaisuuksia padsee muuttamaan painamalla kirjanmerkin paall& hiiren oikeaa nappéainté.
Ominaisuudet (Properties)-kohdasta voidaan muuttaa kirjanmerkin tekstié ja osoitetta johon kirjanmerkki
johtaa. Kirjanmerkin poistaminen tapahtuu menemalld kirjanmerkin paalle ja painamalla hiiren oikeaa
nappdintd. Valitse listasta Delete.

Kirjanmerkkeja kertyy verkkoa paljon kdyttavélle henkil6lle niin paljon, etteivat kaikki tarpeelliset linkit
lopulta mahdu selaimen linkkiriville. Tallgin linkkeja taytyy kansioida, eli yhdistdd samansiséltoiset linkit
yhteiseen kansioon, joka puolestaan nakyy linkkirivilla.

Kansioiden luonti onnistuu:

Firefox: Kirjanmerkit (Bookmarks) - Jarjestele kirjanmerkkeja (Manage Bookmarks)
IE: Paina ensin Alt-ndppaintd. Suosikit (Favorites) - Jérjestele suosikkeja (Organize Favorites)

7. Sivuhistoria ja evasteet

Surffaillessasi Internetissa jattad liikkumisesi monenlaisia jalkia verkkoon, sek& koneelle jolla surffaat.
Kotikoneella néista jaljistd harvoin on haittaa, mutta yleisessé kaytossa oleviin koneisiin jadvat jaljet voi-
vat olla kiusallisia. Koneelle jaavia jalkia on monenlaisia: koneessa oleva sivuhistoria tallentaa muistiin
osoitteet joissa kayt, valimuistiin tallentuu kokonaisia sivuja, evésteet taas ovat sinua koskevaa tietoa, jota
tallennetaan sivuilla kdynnin yhteydessa.

Selaimissa kaikki yksityisyystiedot saadaan poistettua yhdella painikkeella:

Firefox: Tyokalut (Tools) = Tyhjennd yksityisyystietoja (Clear Private Data)
IE: Tyokalut (Tools) > Tyhjenné selaustiedot (Delete Browsing History)
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jonka osoitetta ei muista, mutta jolla surffaili joitakin paivia sitten. D= Edt Yew Go  Bookmarks
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Sivuhistoria tallentaa kaikki osoitteet, jotka kirjoitetaan selaimen 0soi-
tekenttd&n sekd kaikki ne sivut, joilla olet kdynyt. Voit tarkistaa onko
sivuhistoriasi tyhjennetty painamalla selaimen osoitekentén padssa ole-
vaa alaspéin osoittavaa nuolta. Avautuva valikko ndyttadd kaikki osoit-
teet jotka olet kirjoittanut osoitekenttddn. Mikali valikko on tyhja, on
sivuhistoria tyhjennetty, jos taas valikko siséltdd listan osoitteita, voit
valita niistd haluamasi ja siirtyd lukemaan sivua.
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Evésteet, cookies - ndma kaikki tarkoittavat samaa asiaa. Vieraillessasi jollakin sivulla, selain kerad toi-
minnoistasi tietoja ja tallettaa ne k&yttdmallesi tietokoneelle. Palatessasi uudelleen télle sivulle, hakee se-
lain evésteen tietokoneelta. Perustuen edelliseen kéyntiisi, selain ndyttaa sinulle esim. sellaisia mainoksia,
palveluja ja uutisia, joiden kuvitellaan kiinnostavan erityisesti sinua.

Selaimen valimuistiin tallentuu kokonaisia Internet-sivuja. Sivujen tallentamisella nopeutetaan sivujen
selausta ja valimuistissa olevia sivuja paédstaan katselemaan myds off-line -tilassa.

8. Selaimen asetukset

Selaimeen on mahdollista tehdd monenlaisia asetuksia aloitussivun maéarityksen liséksi. Selain voidaan
mm. asettaa estdméén ponnahdusikkunat ja toimimaan oletusselaimena. Kaikki selainta koskevat asetuk-
set tehdaan selaimen valikosta Tyokalut (Tools).

Popupit eli ponnahdusikkunat ovat ikkunoita jotka ponnahtavat itsestén esiin ja siséltavat padosin mai-
noksia. Toisinaan ponnahdusikkunat siséltdvat kuitenkin tarpeellista tietoa mainosten sijaan.

Selaimeen voidaan maéaritella milt4 sivulta ponnahtavat ikkunat sallitaan ja milta ei. Esimerkiksi yliopis-
tolla kaytdssa olevaa postiohjelma Webmailia olisi hyvin vaikea kayttda, jos ponnahdusikkunat olisi ko-
konaan estetty. Webmailissa uusi viesti kirjoitetaan uuteen avautuvaan ikkunaan.

Yliopiston koneilla kaikki yliopiston koneilta tulevat ponnahdusikkunat on automaattisesti sallittu. T&sté
syystd Webmailin kaytto ei yliopiston koneilla aiheuta ilmoitusta estetystd ponnahdusikkunasta.
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9. Tulostaminen

Néaytolta lukeminen on hitaampaa kuin paperilta, eikéd sdhkoiseen materiaaliin voi lukemisen aikana tehda
merkint0j&. Verkossa olevan materiaalin tulostaminen on siis hyvin yleistd. Kaikki tieto kotisivuilla ei
kuitenkaan ole kiinnostavaa, 80 sivun mittaisesta tekstistd ainoastaan 15 saattaa sisaltaa sinulle hyddyllis-
té tietoa. Selaimet siséltavatkin monipuolisia tulostustoimintoja, joita on hyva oppia kayttamaan hukkatu-
lostuksen valttamiseksi.

Tulostuksen tilaa paastadn katsomaan Kaynnistd (Start) - Asetukset (Settings) = Tulostimet ja faksit
(Printers and Faxes) ja tuplaklikkaamalla tulostinta. Avautuvassa ikkunassa ndhdaan tulostimella olevat
ty6t. Tulostuksen peruuttaminen tapahtuu painamalla haluttua tulostusty6ta hiiren oikealla painikkeella ja
valitsemalla Cancel. My6s Document-valikko siséltdd peruutus-toiminnon.

& TUKE_BP33B_LJ4100DTN on brett. ltdk.ad. helsinki.fi =138

Printer Document  Yiew Help

Document Mame Skatus naner Pages Size Subrff

Microsoft Word - Tyoaseman kayt Melilallar] msilenti 73 Z00 KB 11:17
Pause
Restart

Cancel

| S Properties s

Cancels the selected documents.

Mikéli tulostuksen peruuttaminen ei endé onnistu tietokoneella, voi kdynnistyneen tulostustyon keskeyt-
ta& printteristd (siis itse printterilaitteesta). Printtereissd, mallista riippuen, on selkedsti muista erottuva
Peruuta ty0 -painike, jota painamalla aktiivisena oleva tulostustyd peruutetaan. Tyén peruuttaminen ja
tulostuksen keskeytys onkin kannattavaa silloin, kun huomaat saavasi tulosteeksi jotakin aivan muuta
kuin olit suunnitellut.
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Tulostaessa on erittdin tdrkedd huomioida mihin tulostettu nippu lopulta tulostuu. Kaikki koneella néky-
vat printterit eivat valttdmatta sijaitse aivan tyfaseman vieressa. Joillakin printtereistd on myds erityis-
ominaisuuksia kuten kaksipuolinen tulostus. Tulostuskiintiolld tulostavan opiskelijan kannattaakin heti
alkuun opetella taloudellinen tulostus: kaksi A4:8& yhdelle arkille ja vieldpa kaksipuolisesti.

1. Mene valikkoon Tiedosto (File) = Tulosta... (Print...)
2. Valitse alasvetovalikosta sopiva printteri tai tyydy oletusprintteriin
3. Katso Ominaisuudet (Properties)-painikkeella tulostimen ominaisuuksia
4. Kaksipuoleinen tulostus
5. Kuinka monta sivua / A4
O  TUKE_BP333_LIA100DIN on bret L ad.elink. 1§ Document Propertes
Pinter | Lapout | Paper/Qualty | Job Retention
Mame: | Mibrett ek adhekinki fATUKE_BF338_L | [ Properesy | Orenlalion
e T AN CASEE AE 1 S it

Type: p. brons\Luokka_Basaar () Rotated Landscape Side 1 Side 2
weie ok Luokka_Biomedicum
Whetel |\branLuokka_Puskessuo S =
Comment; |SbromstLuokka Terkko it ta s fint on Both Sides
HF Laserlet 4100 PCL 6 B  Mone =
HP Laserlet 4100 PS5 (@ Flip on Long Edoe =
Fiint 13092 | picygsoft Dffice Document Image Wiiter © Fip on Short Edge —
PDF*Chanae 3.0 o — B S =
@ Al TomETorEopies: |1 =
P - 5 K Page Order
O Pages - fom: |1 o |1

& X 5 @ Figrt to Back.
12 B (© Back to Frant

Print Frames Pageg Fer Shest | 1 v

— 5
4
:
3
o e 1 : T
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Tulostaminen pdf-tiedostomuotoon onnistuu PDF-printterilld. Valitse printterilistasta PDF-XChange
3.0 (usein listan viimeisend) ja madrittele tulostuksen muut asetukset normaalisti. Tietokone luo pdf-
tiedoston, pyytéa kéytt4jaa kirjoittamaan tiedoston nimen ja valitsemaan tallennuskohteen.
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Tiettyjen sivujen tulostaminen onnistuu  esim. Pf- ()
dokumenteissa ndpparasti. Avaa dokumentti selaimella ja Fibter

valitse Tiedosto (File) = Tulosta (Print...) Tulostusikkunan Name, [\Wbrel bk e helikifTUKE BF338 L) v |
kenttiin Kirjoitetaan aloitus- ja lopetussivut. el

Type: HP Laserlet 4100 PS
where:  IP_128.214.186.168

Valitun alueen tulostaminen tapahtuu maalaamalla hiirelld i Crinttofis
alue jonka haluat tulostaa. Avaa selaimen tulostusvalikko e e
Tiedosto (File) > Tulosta (Print...) Avautuvasta ikkunasta O Hunber ofgoess (1B

valitse Valinta (Selection).

Tulostaminen kehyksilla toteutetuilta sivuilta onnistuu
myods tulostusikkunassa. Klikkaa hiirelld kehystd, jonka
haluat tulostaa. Mene Tiedosto (File) = Tulosta (Print...) ja

valitse The selected frame. Siimas sl

Pririt Frames

Tulostuksen esikatselu on tarpeellinen toiminto yllatysten valttdmiseksi. Tulostuksen esikatselun kayt-
tdminen kannattaa ottaa tavaksi, silld turhan usein verkosta tulostetut sivut ilmestyvét printteristd mitd
erikoisimmilta ndyttden. Tulostuksen esikatselu 10ytyy Tiedosto (File) = Tulostuksen esikatselu (Print
preview). Tamd valinta aiheuttaa selaimen ndkymassd merkittdvan muutoksen. Sivun ndkyma korvataan
tulostusnédkymalld, jossa padsee tarkastelemaan, milta sivu tulee tulostettuna nayttdmaan.
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Jos ndkyma miellyttaa paina print

Voit kdantaé paperin vaakasuuntaan

Siirry katsomaan muita tulosteen sivuja

Sulkee esikatselun ja palauttaa sivun normaalindkyméan

pONME

10. Hiiren oikea ndppain ja selain

Hiiren oikeasta nappdimesta on paljon hyotya verkossa surffatessa. Oikean ndppaimen avulla voidaan
tehda kirjanmerkkeja, tallentaa, madritelld linkin avautumiskohde, ja katsella sivun lahdekoodia.

Tallentaminen on ndpparéd hiiren oikealla ndppdimelld. Paina sivun padll4 hiiren oikeaa nappéintd. Va-
litse listasta Tallenna sivu nimella... (Save Page As... ) Tallentaminen tarkoittaa sivun tallentamista tie-
tokoneelle omaksi html-tiedostokseen. Téalldin sivua voidaan katsella olematta verkossa, siis off-line -
tilassa. Sivu pysyy muuttumattomana vaikka verkossa oleva alkuperédinen sivu vélilla paivittyisikin.

Samalla tavalla kuvat tallentuvat tietokoneelle omiksi kuvatiedostoikseen. Paina hiiren oikeaa nappéintd
valitsemasi kuvan paallg, valitse Tallenna kuva nimella... (Save Image As...) ja etsi tietokoneelta sopiva
tallennuskohde.

Linkkeihin liittyy useita erilaisia toimintoja. Painaessasi linkin paalla hiiren oikeaa néppdinta voit maari-
telld miten selain toimii linkin suhteen. Linkki voidaan avata omaan ikkunaansa tai omalle valilehdelleen.
Linkin kohde voidaan myds tallettaa tietokoneelle. Erittdin suositeltavaa linkin kohteen tallennus on sil-
loin, kun linkki johtaa johonkin kookkaampaan tiedostoon, kuten esim. opinto-oppaaseen. Voit siis tallen-
taa kohteen koneellesi avaamatta sivua ja tarkastella tiedostoa vasta sitten kun se on latautuneena koneel-
lesi.

Sivun lahdekoodi on hyddyllinen kotisivuja tekeville henkil6ille. Ndhdessaan hienosti tehdyn sivun, voit
tarkastella sivun ldhdekoodia ja selvittdd miten jokin tietty kohta on toteutettu. Sivun lahdekoodin saa
nakyviin valitsemalla hiiren oikean ndppaimen valikosta View Page Source.
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